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1. Цели и задачи дисциплины 

 

Цель изучения дисциплины - способствовать становлению личности, способной 

применять в профессиональной деятельности навыки работы с информационными и 

компьютерными технологиями обработки видеоизображения в рекламе, использовать 

технологии разработки объектов профессиональной деятельности в области рекламы и 

связей с общественностью, телекоммуникаций, управления инфокоммуникациями, систем 

массовой информации, дизайна и медиаиндустрии, а также подробное знакомство с 

существующими информационными мультимедийными технологиями обработки 

видеорекламы. В рамках курса изучается программа Adobe Premiere Pro. Студенты 

знакомятся с понятием цифровой обработки аудио- видеоинформации, форматами и 

кодеками, прикладными программами для обработки цифрового аудио и видео. Студенты 

познакомятся с основными приемами создания цифровых аудио-видеороликов. Также 

студенты изучат устройства обеспечивающие запись и воспроизведение мультимедиа. 

Задачи изучения дисциплины: 

Студент должен знать основные сведения о технических средствах создания 

цифрового аудио и видео, а также их обработки, ознакомиться с процессами записи и 

оцифровки цифровой информации и кодирования ее в популярные мультимедийные 

форматы. 

 изучить характеристики информационных технологий, используемых в 

производстве видеопродукции; классификацию прикладного программного обеспечения в 

сфере видеопроизводства, особенности применения различного программного обеспечения 

на практике; о перспективах развития информационных технологий в области 

видеообработки; 

 Приобретение  навыков  работы  в  среде  программ  видеообработки  на  примере  

Adobe Premiere Pro. 

 Приобретение опыта создания собственной видеорекламы с использованием 

видеоредактора. 

2. Место дисциплины в структуре ООП ВО 

Студенты должны знать основы информатики в объеме школьного курса, владеть 

основами компьютерной грамотности, иметь опыт работы с растровой и векторной 

графикой, владеть основами создания анимации, иметь представление о цветовых моделях 

и основных форматах графических документов, а также иметь навыки практической работы 

на персональном компьютере в операционной среде Windows. 

В процессе изучения дисциплины студент использует знания, получаемые при 

изучении дисциплин «Дизайн и оформление средств массовой информации», «Основы 

дизайна рекламной продукции», «Дизайн графической рекламы». Знания, умения и навыки, 

полученные при изучении данной дисциплины, получат свое развитие в проектной 

деятельности. 

2. Требования к результатам освоения дисциплины 

 

Изучение дисциплины направлено на формирование следующих компетенций: ОПК-

3. 

- ОПК-3 способностью применять знания о процессе создания и распространения 

различных продуктов телепроизводства как многоаспектной индивидуальной и 

коллективной деятельности; 



Студент должен знать: 

 виды компьютерной графики, их отличительные особенности, характеристики, 

особенности хранения, преимущества и назначение растровой и векторной графики. 

Основные понятия, методы и приемы информатики, компьютерных технологий; 

 существующие информационные мультимедийные технологии, используемые в 

области рекламы; 

 форматы публикации данных; 

 основы проектирования информационных технологий в медиаиндустрии; 

 основы теории и методологии проектирования в СМИ, дизайне и медиаиндустрии; 

 информационные мультимедийные технологии, используемые в области 

видеопроизводства; 

 виды компьютерной графики, их отличительные особенности, характеристики, 

особенности хранения, преимущества и назначение растровой и векторной графики; 

 основы работы в программе Adobe Premiere Pro, инструменты и способы создания и 

обработки видеоизображения; 

 форматы видеопродукции; 

 инструменты видеомонтажа и обработки видеоизображения; 

 закономерности разработки инфографики в видеопродуктах; 

 законы монтажа цифрового видео и звука. 

Студент должен уметь: 

 проектировать и реализовывать обработку видеопродукции в сфере СМИ, дизайна и 

медиаиндустрии; 

 разрабатывать различные виды видеопродукции для различных областей 

деятельности, в том числе системы массовой информации, дизайна, медиаиндустрия. 

 использовать инструментарий Adobe Premiere Pro, обрабатывать видеопродукцию, 

получать готовый мультимедийный продукт; 

 проводить монтаж и постобработку видеоматериалов; 

 осуществлять цветовую, звуковую и иную коррекцию видеоизображения; 

 формулировать технические задания и требования к создаваемым мультимедийным 

продуктам; 

 осуществлять самостоятельно и в команде полный цикл процесса разработки 

современного видеопродукта: от разработки идеи и сценария до озвучания и последующего 

ренедера. 

Студент должен владеть: 

 приемами объемного и графического моделирования формы объекта, и 

соответствующей организации проектного материала для передачи творческого 

художественного замысла; 

 векторной и растровой графикой, обработкой видеоматериалов, художественно-

техническим редактированием. 

 терминологией и основными понятиями видеомонтажа; 

 методами и средствами создания современных мультимедиа продуктов, основами 

работы с видео, звуковыми, графическими, данными. 

 основными приемами создания, конвертации и редактирования мультимедиа 

данных, навыками объединения разных видов мультимедиа информации в едином 

информационном продукте; 



 инструментами Adobe Premiere Pro для коррекции видео и звука, создания анимации 

средствами специализированного ПО. 

 

4. Распределение трудоемкости (час.) дисциплины по темам 

и видам занятий 

 

№ 

мо-

ду- 

ля 

№ 

недели 

№ 

те-

мы 

 

Наименование 

темы 

 

Часы 

 

     

Всего 

Лек-

ции 

Лаборат

орные 

Прак-

тичес-

кие 

 

СРС 

1 2 3 4 5 6 7 8 9 

V семестр 

1 1 1 Технические средства,  
используемые при создании 
видеорекламы 

26 4  8 14 

 2 2 Современные технологии 
нелинейного монтажа 

28 4  10 14 

 3 3 Обработка видео в программе 
Adobe Premiere Pro 

24 4  8 12 

 4 4 Разработка комплексного 
видеопродукта с помощью 
программ пакета Adobe 

30 6  10 14 

    108 18  36 54 

 
5. Содержание лекционного курса 

 

№ 

темы 

Всего 

часов 

№ 

лекции 

Тема лекции. Вопросы, отрабатываемые на лекции Учебно-

методическое 

обеспечение 

1 2 3 4 5 

1 2 1 Технические  средства,  используемые  при  создании 
видеорекламы.   Типы   и   виды  средств   создания 
видеорекламы.  Технические  особенности  создания 

видеорекламы. 

1-9 

1 2 2 Современные технологии нелинейного монтажа 2 

2 2 3 Сбор сцен в программе Adobe Premiere Pro 1-7 

2 2 4 Библиотека   видеоэффектов   в   программе   Adobe 
Premiere Pro 

3-8 

2 2 5 Библиотека  видеопереходов  в  программе  Adobe 
Premiere Pro 

2-6 

2 2 6 Обработка звука в программе Adobe Premiere Pro 1-4 

3 2 7 Интеграция Adobe Premiere Pro и Adobe Photoshop 3-7 

3 2 8 Интеграция Adobe Premiere Pro и Adobe After Effects 1-6 

3 2 9 Виды современной цифровой видеопродукции 1-6 



6. Содержание коллоквиумов 

Коллоквиумы не предусмотрены учебным планом. 

 

7. Перечень практических занятий 

 

№ 

темы 

Всего 

часов 

№ 

занятия 

Тема практического занятия. Вопросы, 

отрабатываемые на практическом занятии 

Учебно-

методическое 

обеспечение 

1 2 3 4 5 

1 4 1-2 Технические  средства,  используемые  при  создании 
видеорекламы.   Типы   и   виды  средств   создания 
видеорекламы.  Технические  особенности  создания 

видеорекламы. 

1-9 

1 4 3-4 Современные технологии нелинейного монтажа 2 

2 4 5-6 Сбор сцен в программе Adobe Premiere Pro 1-7 

2 4 7-8 Библиотека   видеоэффектов   в   программе   Adobe 
Premiere Pro 

3-8 

2 4 9-10 Библиотека  видеопереходов  в  программе  Adobe 
Premiere Pro 

2-6 

3 4 11-12 Обработка звука в программе Adobe Premiere Pro 1-4 

3 4 13-14 Интеграция Adobe Premiere Pro и Adobe Photoshop 3-7 

4 4 15-16 Интеграция Adobe Premiere Pro и Adobe After Effects 1-6 

4 4 17-18 Виды современной цифровой видеопродукции 1-6 

 

8. Перечень лабораторных занятий 

Лабораторные работы не предусмотрены учебным планом. 

 

9. Задания для самостоятельной работы студентов 

 

Самостоятельная работа студентов способствует углублению и расширению знаний, 

формированию интереса к познавательной деятельности, овладению приемами процесса 

познания, развитию познавательных способностей.  

Аудиторная самостоятельная работа составляет различные виды контрольных, 

творческих и практических заданий во время практических занятий. 

Внеаудиторная самостоятельная работа включает выполнение письменного 

домашнего задания, подготовка к разбору ранее прослушанного лекционного материала на 

практическом занятии, подготовка доклада, выполнение реферата, написание эссе, 

подготовка презентации на выбранные темы и др.  

 

№ 

темы 

Всего 

Часов 

Вопросы для самостоятельного изучения 

(задания) 

Литература 

 2 3 4 

1 14 Ключевые термины видеообработки: Сценарий, 

Секвенция, проект 

2-6 

2 14 Анимация в программе Adobe Premiere Pro 1-4 

3 12 Работа с титрами в программе Adobe Premiere Pro 3-7 

4 14 Обработка звука в программе Adobe Audition 1-6 



10. Расчетно-графическая работа 

Расчетно-графическая работа не предусмотрена учебным планом 

11. Курсовая работа 

Курсовая работа не предусмотрена учебным планом 
 

12. Курсовой проект 

Курсовой проект не предусмотрен учебным планом. 

 

13. Фонд оценочных средств для проведения промежуточной аттестации 
обучающихся по дисциплине (модулю) 

 
В процессе изучения дисциплины должны сбыть сформированы следующие 

компетенции: 

ОПК-3 способностью применять знания о процессе создания и распространения 

различных продуктов телепроизводства как многоаспектной индивидуальной и 

коллективной деятельности; 

 

№ Название  Составляющие действия Технологии  Средства   и 

пп компетенции  компетенции     формирования  технологии 

            оценки 

         

 

ОПК-3 способностью 

применять знания о 

процессе создания и 

распространения 

различных продуктов 

телепроизводства как 

многоаспектной 

индивидуальной и 

коллективной 

деятельности; 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Студент должен знать: 
- виды компьютерной графики, 
их отличительные особенности, 
характеристики, особенности 
хранения, преимущества и 
назначение растровой и 
векторной графики. Основные 
понятия, методы и приемы 
информатики, компьютерных 
технологий; 
- существующие 
информационные 
мультимедийные технологии, 
используемые в области 
рекламы;  
- форматы публикации данных; 

- основы проектирования 

информационных технологий 

в медиаиндустрии; 

- основы теории и методологии 

проектирования в СМИ, 

дизайне и медиаиндустрии; 
- информационные 
мультимедийные технологии, 
используемые в области 
видеопроизводства; 
- основы работы в программе 
Adobe Premiere Pro, 

Лекции 
Практические 
занятия 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Тестирование 

  

  

  

  

  

  

  

  

  

  

  



инструменты и способы 
создания и обработки 
видеоизображения;  
- форматы видеопродукции; 

- инструменты видеомонтажа и 

обработки видеоизображения; 

- закономерности разработки 

инфографики в 

видеопродуктах; 

- законы монтажа цифрового 

видео и звука. 

Студент должен уметь: 
- проектировать и 
реализовывать обработку 
видеопродукции в сфере СМИ, 
дизайна и медиаиндустрии;  
- разрабатывать различные 
виды видеопродукции для 
различных областей 
деятельности, в том числе 
системы массовой информации, 
дизайна, медиаиндустрия. 
- использовать 
инструментарий Adobe 
Premiere Pro, обрабатывать 
видеопродукцию, получать 
готовый мультимедийный 
продукт; 
- проводить монтаж и 
постобработку 
видеоматериалов; 
- осуществлять цветовую, 
звуковую и иную коррекцию 
видеоизображения; 
- формулировать технические 
задания и требования к 
создаваемым мультимедийным 
продуктам; 
- осуществлять 
самостоятельно и в команде 
полный цикл процесса 
разработки современного 
видеопродукта: от разработки 
идеи и сценария до озвучания и 
последующего ренедера. 

Лекции 
Практические 

занятия 
Деловые 
психологические 
интерактивные 
игры 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Тестирование 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Студент должен владеть: 
- приемами объемного и 
графического моделирования 
формы объекта, и 
соответствующей организации 

Лекции 
Практические 

занятия 

Моделирование 

ситуаций 

Тестирование 

 

 

 

 



проектного материала для 
передачи творческого 
художественного замысла; 
- векторной и растровой 
графикой, обработкой 
видеоматериалов, 
художественно-техническим 
редактированием. 
- терминологией и основными 
понятиями видеомонтажа; 
- методами и средствами 
создания современных 
мультимедиа продуктов, 
основами работы с видео, 
звуковыми, графическими, 
данными. 
- основными приемами 
создания, конвертации и 
редактирования мультимедиа 
данных, навыками объединения 
разных видов мультимедиа 
информации в едином 
информационном продукте; 
- инструментами Adobe 
Premiere Pro для коррекции 
видео и звука, создания 
анимации средствами 
специализированного ПО. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

  

  

  

  

  
 

УРОВНИ ОСВОЕНИЯ КОМПЕТЕНЦИИ ОПК-3 

Наименование компетенций 

 

ОПК-3 

Формулировка: 

способностью применять знания о процессе создания и 

распространения различных продуктов телепроизводства как 

многоаспектной индивидуальной и коллективной деятельности; 

 

 

 

Ступени уровней освоения 

компетенций 

Отличительные признаки 

 

Пороговый 

(удовлетворительный) 

- Знает: общие приемы использования инструментов 

видеомонтажа и обработки видеоизображения; 

закономерности разработки инфографики в видеопродуктах; 

законы монтажа цифрового видео и звука. 

- Умеет: частично использовать инструментарий Adobe 

Premiere Pro, обрабатывать видеопродукцию, получать 

готовый мультимедийный продукт; проводить монтаж и 

постобработку видеоматериалов; осуществлять цветовую, 

звуковую и иную коррекцию видеоизображения; 



- Владеет: частично векторной и растровой графикой, 
обработкой видеоматериалов, художественно-техническим 
редактированием; терминологией и основными понятиями 
видеомонтажа;  

Продвинутый 

(хорошо) 

- Знает: детально приемы использования инструментов 

видеомонтажа и обработки видеоизображения; 

закономерности разработки инфографики в видеопродуктах; 

законы монтажа цифрового видео и звука. 

- Умеет: хорошо использовать инструментарий Adobe 

Premiere Pro, обрабатывать видеопродукцию, получать 

готовый мультимедийный продукт; проводить монтаж и 

постобработку видеоматериалов; осуществлять цветовую, 

звуковую и иную коррекцию видеоизображения; 

- Владеет: хорошо векторной и растровой графикой, 

обработкой видеоматериалов, художественно-техническим 

редактированием; терминологией и основными понятиями 

видеомонтажа;   

 

Высокий 

(отлично) 

- Знает: в совершенстве приемы использования 

инструментов видеомонтажа и обработки видеоизображения; 

закономерности разработки инфографики в видеопродуктах; 

законы монтажа цифрового видео и звука. 

- Умеет: детально использовать инструментарий Adobe 

Premiere Pro, обрабатывать видеопродукцию, получать 

готовый мультимедийный продукт; проводить монтаж и 

постобработку видеоматериалов; осуществлять цветовую, 

звуковую и иную коррекцию видеоизображения; 

- Владеет: детально векторной и растровой графикой, 

обработкой видеоматериалов, художественно-техническим 

редактированием; терминологией и основными понятиями 

видеомонтажа; 

 

Для определения достигнутой обучающимся степени освоения материала 

используется система тестов.  

Шкала оценивания результатов: 

 0-30% неудовлетворительно 

 31-60% удовлетворительно(пороговый уровень) 

 61-80% хорошо(продвинутый уровень) 

 81-100% отлично(высокий уровень) 

 

Организация и проведение межсессионной аттестации студентов 

Межсессионная аттестация представляет собой важнейшее средство, 

обеспечивающее преподавателю обратную связь, которая является руководством в выборе 

методов, форм и приемов преподавания, ориентируя на уровень знаний и умений 

конкретной группы. Это также и способ самоконтроля как учебное действие самого 

студента, который должен заботиться о том, чтобы не накапливать неотработанные лекции 



и семинары, непрочитанные тексты учебной и научной литературы, а также задания для 

самостоятельной работы, не откладывая усвоение пропущенного материала и выполнения 

курсовой работы до сессии. 

Основными задачами аттестации являются: 

- промежуточная проверка качества (глубины) усвоения студентом пройденного 

учебного материала; 

- контроль ритмичности работы студентов в течение семестра; 

- упорядочение самостоятельной работы студентов; 

- планирование основных корректирующих мер по преодолению обнаруженных 

недостатков и умножению достигнутых успехов в обучении, изучение и распространение 

положительного опыта организации учебной деятельности, эффективных приемов и 

методов преподавания, организации самостоятельной работы студента. 

Конечной целью контроля учебной деятельности студентов является улучшение 

общей профессиональной подготовки специалистов. 

Аттестацию студента проводят преподаватели, осуществляющие в Институте 

соответствующие виды учебной деятельности: лекционные и практические занятия, 

руководство курсовыми работами. 

При межсессионной аттестации студента учитываются: 

1) посещаемость студентом лекций и практических занятий; 

2) текущая успеваемость студента.  

Основными критериями ее оценки являются:  

а) активность участия студентов в практических занятиях и коллоквиумах;  

б) уровень знаний, умений и навыков, продемонстрированных студентом на 

практических занятиях;  

в) результаты выполнения письменных контрольных и самостоятельных работ, 

тестов, эссе и т. п.; 

г) систематичность работы над курсовой работой (курсовым проектом);  

д) степень выполнения индивидуальных заданий по данной дисциплине.  

По решению учебно-методической комиссии кафедры эти критерии могут быть 

расширены и дополнены. 



Контроль текущей успеваемости и качества знаний студента осуществляется 

преподавателями, за которыми закреплены дисциплины учебного плана, посредством 

выставления оценок на основании федерального государственного образовательного 

стандарта по направлению (42.03.04 «Телевидение») и рабочей программы по аттестуемой 

дисциплине. 

Объектом оценивания являются основные компоненты учебного процесса, которые 

включают в себя: учебную дисциплину (мотивацию студента, его активность при 

получении знаний, своевременное прохождение контрольных мероприятий), посещаемость 

занятий студентом, степень усвоения им теоретических знаний, уровень овладения 

практическими умениями и навыками во всех видах учебной деятельности, его способность 

к самостоятельной научно-исследовательской работе и др. К концу второй недели 

межсессионного контроля студенты должны выполнить все запланированные на данный 

период контрольные мероприятия (коллоквиумы, защита лабораторных работ, сдача 

контрольных, защита курсовых работ, рефератов, выступления студентов с докладами, 

сообщениями, проектами на практических (семинарских) занятиях, тестирование студентов 

и т.д.). 

В период проведения межсессионного контроля преподаватель, за которым 

закреплены дисциплины учебного плана, вправе применить различные формы контроля 

качества знаний, умений и навыков студентов. 

Межсессионная аттестация проводится в разнообразных формах (контрольная 

работа, диктант, тестирование, компьютерный контроль по отдельным разделам и темам 

учебных программ, написание и защита реферата, творческие работы, составление 

библиографии, подготовка докладов и выступление с ними, оформление альбомов, 

разработка конспектов, планирований отдельных направлений учебной, научной, 

исследовательской деятельности, компьютерная презентация материалов и т.п.), 

отражающих специфику учебной деятельности кафедры «Медиакоммуникации». 

Виды заданий для проведения межсессионной аттестации студентов, их содержание 

и характер имеют вариативный и дифференцированный характер, учитывая специфику 

данной дисциплины, индивидуальные особенности студента. 

Межсессионная аттестация студентов, обучающихся по всем направления очной 

формы по данной дисциплине, проводится 1 раза в семестр. Межсессионный контроль 



оценивается по шкале: "аттестован", "неаттестован". Результаты аттестации проставляются 

в ведомость, которая находится в дирекции института. 

 

 

Вопросы для экзамена 
 

Не предусмотрено учебным планом 
 

Вопросы для зачета 
 
1. Форматы цифровой аудио и видео информации. 

2. Спектры аналоговых и цифровых сигналов 

3. Звуковые карты и их разновидности. 

4. Декодеры для формата MP3 

5. Методы сжатия звуковых файлов для различных форматов 

6. В чем измеряется Частота звука 

7. Разрядность квантования 

8. Семплирование 

9. Как называется цифровой интерфейс, используемый для захвата цифрового видео 

формата DV? 

10 Существует ли ограничение на количество видео- и аудио- треков в 

11. Premiere ? 

12. Можно ли рассчитать (render) не весь видеофильм, а только выбранную часть? 

13. Как соотносятся видео-файлы, используемые в проекте и сам файл проекта Premiere? 

14. Можно ли импортировать один проект Premiere в другой? 

15. Что означает термин двухпроходное (2-PASS) сжатие? Сжатие без потерь и с потерями 
 
 

Тестовые задания по дисциплине 

1. Кадр, в котором человек снят по пояс, называется: 

a. Сверх-крупным 

b. Крупным 

c. Средним 

d. Общим 

2. При монтаже кадров разной крупности время кадра следует распределять как: 

a. Крупный кадр – длиннее, общий – короче 

b. Крупный кадр – короче, общий – длиннее 

c. Длительность одинакова в независимости от крупности 

3. При подготовке видео-материала для российских телеканалов следует использовать 

формат телевизионного вещания 

a. NTSC 

b. PAL 

c. HDTV 

d. CIF 

4. При изменении порядка кадров в монтаже смысл монтажной фразы: a. Меняется. 

b. Не меняется. 

5. На какой вопрос должен отвечать крупный план: 



a. Где? (демонстрация места). 

b. Кто? (демонстрация героя). 

c. Как? (демонстрация эмоций). 

d. Куда? (демонстрация движения). 

6. Что такое субъективная камера? 

a. Это вид из глаз одного из персонажей сцены. 

b. Это вид со стороны независимого наблюдателя, следящего за сценой. 

c. Это камера, фокусное расстояние которой равно фокусному расстоянию глаза человека. 

7. При съемке несколькими камерами диалога двух персонажей камеры должны быть 

расположены: 

a. По одну сторону от линии их взаимодействия. 

b. По разные стороны от линии их взаимодействия. 

c. Только таким образом, что бы каждая камера снимала одного персонажа. 

d. Расположение камер не имеет значения. 

8. Какое соотношение сторон кадра соответствует съемке в режиме широкого экрана 

(Widescreen) на камеру формата miniDV или камеру HD 

a. 2:1. 

b. 4:3. 

c. 16:10. 

d. 16:9. 

9. Каким образом можно передать размер объекта, показав что он очень маленький и легкий 

(выбрать несколько): 

a. Показав для сравнения что-то большое. b. Показав для сравнения что-то маленькое. c. 

Ускорив движение этого объекта. 

d. Замедлив движение этого объекта. 

10. Как можно вызвать окно захвата видео? 

a. File > Capture 

b. Project > Capture 

c. Capture > Capture video 

d. Edit > Capture 

11. Какой инструмент может замедлять или ускорять воспроизведение видео относительно 

его нормальной скрости 

a. Razor tool 

b. Slip tool 

c. Rate stretch tool 

d. Pick tool 

12. Какой видео фильтр позволяет сделать произвольный цвет прозрачным? 

a. Chroma key 

b. Four point garbage mask 

c. Luma matte 

d. Blue screen matte 

13. При размещении видеофрагмента на временной линейке (timeline) в 

верхней части окошка возникает красная линия. Что она означает? 

a. Программа Premiere совершила недопустимую операцию и вскоре будет закрыта. 

b. Видео-фрагмент содержит ошибку, рекомендуется его убрать из проекта. 

c. Видео фрагмент не содержит звука. 

d. Видео-фрагмент закодирован в формате, настройки которого не совпадают с текущими 

настройками проекта или к данному 



видеофрагменту применен видеоэффект, который не был просчитан 

(отрендерен). 

14. При импортировании видео-файла Premier помещает в проект 

a. Ссылку на файл видео-ролика 

b. Сжатую копию файла видео-ролика 

c. В зависимости от настроек импорта либо файл, либо ссылку 

15. Могут ли два разных кадра на DV-кассете иметь один и тот же тайм-код? a. Нет. 

b. Да. 

16. С помощью какого окна можно настраивать параметры примененных видео эффектов, 

контролировать анимацию движения? 

a. Effects. 

b. Video. 

c. Mixer 

d. Effects Control 

17. Какой эффект позволяет управлять цветом посредством сдвига цвета (тональности) по 

цветовому кругу для светлых, средних и темных участков изображения? 

a. Levels 

b. Shadow/Hightlight 

c. Three Way Color Corrector 

d. Simple Color Corrector 

18. Что происходит с видео-роликом, если его размер не совпадает с размером кадра в 

проекте Premiere? 

a. Масштаб автоматически изменяется, с сохранением пропорций, 

если пропорции ролика и кадра не совпадают, добавляются черные полосы. 

b. Масштаб автоматически изменяется без сохранения пропорций. 

c. Масштаб ролика остается неизменным, помещается в видео-кадр как есть. 

d. Такой ролик нельзя добавить в проект. 

19. Можно ли анимировать параметры видеоэффектов? a. Да. 

b. Нет. 

20. По умолчанию видео-фрагмент, имеющий звуковое сопровождение, 

монтируется синхронно со свои звуком. Можно ли их расцеплять или сдвигать друг 

относительно друга? 

a. Нет. 

b. Только сдвигать. 

c. Только расцеплять. 

d. Да, сдвигать и расцеплять. 

21. Где можно разместить текстовые надписи(титры) на экране? a. В любом месте экрана. 

b. Только в центре. 

c. В любом месте экрана, но желательно не ближе, чем на 20% от края экрана. 

22. Какой измерительный инструмент позволяет вывести распределение цветности кадра в 

виде круговой диаграммы 

a. RGB Parade. 

b. CMY Parade. 

c. Vectroscope. 

d. Composite Image. 

23. Каком образом можно сократить объем на диске, занимаемый проектом 

(то есть создать новую компактную версию проекта)? 

a. File> Trim Project 



b. File >Reduce Project 

c. Project>Trim Project 

d. Project>Project Manager 

24. Какой вид сжатия используется в видео-кодеке DV ? a. Межкадровое с потерями. 

b. Внутрикадровое с потерями. c. Сжатие отсутствует. 

d. Сжатие без потерь. 

25. Какой кодек может быть использован в формате файла *.AVI a. Только DV 

b. Только MPEG-4 c. Intel Indeo 

d. Любой, установленный в системе 

26. При сжатии с потерями указывается цветовой профиль, например 4:2:1. 

Как следует понимать данное обозначение? 

a. Доли цветовых компонент красного, зеленого и синего (RGB) 

b. Доли яркости и двух цветоразностных каналов - красный-зеленый, 

синий-желтый 

c. Структуру группы кадров, 4 кадра записываются как разница между предыдущим кадром 

, 2 – как разница между предыдущим и следующим кадрами, 1 как целое изображение. 

d. Версии используемых кодеков 

27. При создании видео для DVD используется кодек: 

a. MPEG-1. 

b. MPEG-2. 

c. MPEG-3. 

d. MPEG-4. 

28. Емкость двухслойного одностороннего DVD диска составляет a. 4,5 Гб 

9 Гб 

b. 13,5 Гб 

c. 18 Гб 

29. Существует ли максимальное ограничение на поток данных (bitrate) для 

видео-файла MPEG-2, предназначенного для записи на DVD? 

a. Да, поток не должен превышать 9,8 Мбит/сек 

b. Да, поток не должен превышать 4,2 Мбит/сек 

c. Да, поток не должен превышать 2 Мбит/сек 

d. Нет, поток данных может быть любой\ 
 

14. Образовательные технологии 

Чтение лекций осуществляется с использованием компьютерных презентаций. В 

ходе лекционных и практических занятий используется мультимедийное оборудование 

(компьютер, интерактивная доска и проектор). 

Практические занятия направлены на углубление научно-теоретических знаний и 

овладение определенными методами самостоятельной работы, которое формирует 

практические умения. Перед практическим занятием следует изучить конспект лекции и 

рекомендованную преподавателем литературу. 

В процессе обучения широко используются такие активные и интерактивные формы 

занятий, как тематические дискуссии, мозговая атака, презентации, ситуативные 

симуляции, ролевые игры. Предусмотрены мастер-классы с практикующими 

специалистами. 

Методы интерактивной образовательной деятельности: 

Проблемное обучение – стимулирование студентов к получению знаний, 

необходимых для решения конкретной проблемы, возникающей в процессе разработки. 



Удельный вес занятий, проводимых в интерактивных формах, составляет порядка 50 

%.  

 

15. Перечень учебно-методического обеспечения для обучающихся по 

дисциплине 

 

Основная литература 

1. Григорьева И.В. Компьютерная графика [Электронный ресурс]: учебное пособие/ 

Григорьева И.В.— Электрон. текстовые данные.— М.: Прометей, 2012.— 298 c.— Режим 

доступа: http://www.iprbookshop.ru/18579 .— ЭБС «IPRbooks», по паролю 

2. Радомский В.М. Информационные системы и технологии в изобретательской 

деятельности и рекламе [Электронный ресурс]: учебное пособие/ Радомский В.М.— 

Электрон. текстовые данные.— Самара: Самарский государственный архитектурно-

строительный университет, ЭБС АСВ, 2012.— 148 c.— Режим доступа: 

http://www.iprbookshop.ru/20466 .— ЭБС «IPRbooks», по паролю 

3. Розенсон И. А. Основы теории дизайна : учеб. / И. А. Розенсон. - СПб. [и др.] : 

Питер, 2010. - 219 с. (50 экз.) 

4. Цветкова А.В. Информатика и информационные технологии [Электронный 

ресурс]: учебное пособие/ Цветкова А.В.— Электрон. текстовые данные.— Саратов: 

Научная книга, 2012.— 182 c.— Режим доступа: http://www.iprbookshop.ru/6276 .— ЭБС 

«IPRbooks», по паролю 

 

Дополнительная литература 

5. Аббасов И.Б. Основы графического дизайна на компьютере в Photoshop CS6 

[Электронный ресурс]: учебное пособие/ Аббасов И.Б.— Электрон. текстовые данные.— 

М.: ДМК Пресс, 2013.— 238 c.— Режим доступа: http://www.iprbookshop.ru/29256 .— ЭБС 

«IPRbooks», по паролю 

6. Зинюк О.В. Компьютерные технологии. Часть 1. Обработка растровых 

изображений [Электронный ресурс]: учебное пособие/ Зинюк О.В.— Электрон. текстовые 

данные.— М.: Московский гуманитарный университет, 2011.— 80 c.— Режим доступа: 

http://www.iprbookshop.ru/8608 .— ЭБС «IPRbooks», по паролю 

7. Лебедева И.М. Реалистическая визуализация трехмерных моделей в среде 

AutoCAD [Электронный ресурс]: учебное пособие/ Лебедева И.М.— Электрон. текстовые 

данные.— М.: Московский государственный строительный университет, ЭБС АСВ, 2011.— 

52 c.— Режим доступа: http://www.iprbookshop.ru/16354 .— ЭБС «IPRbooks», по паролю 

8. Лепская Н.А. Художник и компьютер [Электронный ресурс]: учебное пособие/ 

Лепская Н.А.— Электрон. текстовые данные.— М.: Когито-Центр, 2013.— 172 c.— Режим 

доступа: http://www.iprbookshop.ru/15315 .— ЭБС «IPRbooks», по паролю 

9. Молочков В.П. Microsoft PowerPoint 2010 [Электронный ресурс]/ Молочков 

В.П.— Электрон. текстовые данные.— М.: Интернет-Университет Информационных 

Технологий (ИНТУИТ), 2011.— 117 c.— Режим доступа: http://www.iprbookshop.ru/16683 

.— ЭБС «IPRbooks», по паролю 

10. Перемитина Т.О. Компьютерная графика [Электронный ресурс]: учебное пособие/ 

Перемитина Т.О.— Электрон. текстовые данные.— Томск: Эль Контент, Томский 

государственный университет систем управления и радиоэлектроники, 2012.— 144 c.— 

Режим доступа: http://www.iprbookshop.ru/13940 .— ЭБС «IPRbooks», по паролю 
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11. Рафаэл Гонсалес Цифровая обработка изображений [Электронный ресурс]/ 

Рафаэл Гонсалес, Ричард Вудс— Электрон. текстовые данные.— М.: Техносфера, 2012.— 

1104 c.— Режим доступа: http://www.iprbookshop.ru/26905 .— ЭБС «IPRbooks», по паролю 

12. Сжатие цифровых изображений [Электронный ресурс]/ О.О. Евсютин [и др.].— 

Электрон. текстовые данные.— М.: Горячая линия - Телеком, 2013.— 124 c.— Режим 

доступа: http://www.iprbookshop.ru/25086 .— ЭБС «IPRbooks», по паролю 

13. Соловьев М.М. 3DS Max 9 [Электронный ресурс]: самоучитель/ Соловьев М.М.— 

Электрон. текстовые данные.— М.: СОЛОН-ПРЕСС, 2007.— 376 c.— Режим доступа: 

http://www.iprbookshop.ru/20837 .— ЭБС «IPRbooks», по паролю 

 

Периодические издания 

14. Русская литература и журналистика в движении времени. Издательство «Факультет 

журналистики Федерального государственного образовательного учреждения 

высшего образования Московский государственный университет имени М.В. 

Ломоносова» Архив (2012) № 1. ISSN 2410-9312. Режим доступа: 

http://elibrary.ru/contents.asp?titleid=54365 

 

Интернет-ресурсы 

15. www.ict.edu.ru/  – Система федеральных образовательных порталов 

«Информационно-коммуникационные технологии в образовании» 

16. 3DCenter.ru  - Популярно о трехмерном http://www.3dcenter.ru  

17. Cool Edit Pro и оцифрованный звук / В. Галактионов 

http://www.osp.ru/pcworld/2003/04/142_print.htm/  

18. Графическая библиотека OpenGL / Ю. Баяковский, А. Игнатенко, А. Фролов 

http://library.graphicon.ru/paper/481/  

 

Источники ИОС 

19. Информационно-образовательная  среда [Электронный ресурс] Режим доступа: 

https://portal3.sstu.ru/Facult/MFPIT/MFPIT-RKD/TLVD/B.1.2.12/default.aspx  

 

16. Материально-техническое обеспечение дисциплины. 

Для чтения лекций используются аудитория, оснащенная компьютером с выходом в 

Интернет системные требования: AMD Athlon 64x2 Dual core 5000+ (2 

cpu)/2Gb/150Gb/817Mb/Nvidia GeForce 8200, проектор Acer P5280 - для демонстрации 

учебно-методического материала. Программное обеспечение: MS Office 2007. 

Для проведения практических занятий используются аудитория, оснащенная 

компьютером с выходом в Интернет системные требования: Intel Core 2 Quad Q9400 

2.66Ghz/4Gb/300Gb/2Gb Nvidia GeForce 9600 GT. Программное обеспечение: Windows 7, 

Adobe Master Collection CS6, Corel Draw X4, MS Office 2007, Антивирус Kaspersky Endpoint 

8. 
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